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Logivision has attempted to make this document accurate. Logivision is not responsible for any direct, incidental, or 
consequential damages resulting from this documentation or inaccuracies within. Specifications are subject to 
change.  

Printed in Canada. 
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Accounts receivable   

About the application  

Logivision is a corporation specialized in the development of software for the retail industry with a particular focus 
on operation systems for front-end terminals. Innovative and always at the forefront of new technological 
developments, Logivision is committed to improving the service and products we provide to our customers.  

Accounts receivable overview  

The accounts receivable software provides control of the customer charge file between L-BOSS system and L-POS 
terminals. The A/R module ensures that credit limits assigned to your customers are enforced. Timely printout of 
customer statements and account aging reports often means the difference between profits or losses with 
outstanding accounts. System features include:  

 

Virtually unlimited customer records. 

 

Multiple customer contact records per account allow statements for one account to show invoices for each 
contact (as for a family using a common account) 

 

Credit limit per customer type (risk level) 

 

Limit for check payment privilege per transaction and per week 

 

Real-time account balance on L-POS terminals 

 

Charge sale stub receipt printing  

 

Invoice printing on 8.5" by 11" forms  

 

Accounts can be created from front-end terminals 

 

Interest posting. 

 

Customer picture can be scanned for display on front-end terminals.  

Note: A working knowledge of the L-BOSS system and the L-POS system are pre-requisites to using the L-BOSS 
A/R system. This document covers the L-BOSS accounts receivable option as interfaced with the L-POS 
application. Other front-end terminals may have different features or limitations not covered in this document.  
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Navigating the L-BOSS Application  

Using the mouse  

Throughout the L-BOSS application you will find drop down menus and main screen icon groups to navigate 
through the program or launch utilities. The most commonly used drop down menu options have been included as 
buttons on the L-BOSS desktop to facilitate access. In other words, some drop down menu options lead to the 
same location as clicking that option's icon counterpart.   

Not all options have buttons, and must be launched from the drop down menu. Options that are not often required, 
or single use setup tools (used to configure the system at installation time) do not have main screen buttons. If an 
option does not appear to have a button, use the drop down menus to locate and launch that option.  

Using the keyboard  

As with most Windows style applications, the drop down menu titles and options are also accessible using the 
keyboard. This can actually be faster than navigating with the mouse, after you've memorized the keystrokes 
involved for a specific task. The keystrokes associated with menu titles and options are underlined. For example, 
the "File" menu has an underscore under the "F": 
Hold down the [Alt] key on the keyboard. 
Simultaneously, press the [F] key. 
The File menu opens.   

The options in the drop down menus also have underscored letters. Once a drop down menu is open, you can 
press the letter that is associated with the option you wish to launch. You can also use the [up] or [down] arrow 
keys to select the menu option, and then press [Enter] to launch the option.  

Within applications or utilities, the [Tab] key will move the cursor from one box, window or editable field to the next, 
in a pre-set order. Holding down the [Shift] key and pressing the [Tab] key will reverse the pre-set order. Once the 
cursor is on an option, press the [Enter] key to launch the option.  

Understanding Communications  

While the network is "down" L-BOSS cannot communicate with the front end. In this situation no customer account 
balances will be available until the system returns to normal. L-POS front end stations will prompt the cashier with a 
"server not available - continue anyway?" error message. At this point it is store policy to allow or prohibit account 
charges.  

Backups Are Important!  

Is your sales information important? Is your database important? Is your hardware setup important? The answer is 
always YES! What happens if the system crashes? How can I protect my information? Like any "mission critical" 
information, your L-BOSS installation should be archived on a regular basis. Normally, your Logivision dealer will 
suggest ways to protect your information, based on the type of installation you have, and how much space your 
data actually takes up. In most situations, you'll want to backup every night, (or other time when the system is not 
busy). 
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Setting up L-BOSS Accounts receivables  

The accounts receivable option must be enabled on the license key before you can use the accounts receivable 
option. If your license does not include the A/R option, contact your reseller.  

In order to use a customer account on the POS you need to complete several steps.  

 

Create risk levels 

 

Create client shopper levels 

 

Create client records (accounts) 

 

Create client contact record(s) for each account 

 

Adjust accounts for opening balances 

 

Send the account records to the POS terminals 

 

Adjust the account related settings in PosSetup 

 

Set up the POS keyboard or touch screen with an account button, a payment button and a house charge 
button. 

 

Set up the scanner definition table to scan account cards 

 

Printing account cards 

 

Printing account reports 

 

Printing statements  

  

Note: This manual related to the use of accounts with the Accounts receivable module.   

From the L-BOSS main menu 
open the Maintenance program.  

The accounts receivable module 
and the preferred shopper module 
use the same customer 
information from the database.   

The accounts receivable option is 
required to post house charges. 
The preferred shopper option is 
required to use points or the 
discount table.   

The same account file is also 
used for positive or negative 
check verification.  
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Opening the account tables  

L-BOSS allows you to create customer records for check cashing, store charges and customer demographics. The 
customer maintenance is accessed using the Maintenance application's "Account" menu, "Customer" option, or the 
"Clients" desktop icon. Each account created must have a link to a customer risk level, and to a client level 
(shopper privilege level). It is good practice to define the related customer tables before adding customers. Note 
that the terms "customer" and "client" are interchangeable.  

From the maintenance application, the Account menu includes the following menu:  

  

Use the required option to access the tables you want to 
program: 

 

Customer is the main account file 

 

Client level is to create shopper privilege levels 

 

Risk level is to manage AR credit balance and check 
spending or check cashing privileges 

 

Account view is a convenient way to open all 3 account 
related tables 

 

Discount accesses the preferred shopper discount table (a 
licensed option for preferred shopper is required) 

 

Custom messages allow you to modify messages that 
appear on account statements. 
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File menu  

The Maintenance application's "File" menu contains common options such as login / logout, language setting etc., 
but is also dynamic. Depending on the table being edited, the options in the "File" menu change to include utilities 
designed to test or verify system integrity for the selected data type. For example, it is important to complete the 

set-up of accounts that were created on the POS 
terminals directly.            

 

Show modified by registers will display a list of the customer records 
that were created or changed on the front-end terminals during a 
transaction. This option is programmable and may not be available on 
your system. 

 

The Send to host option of the "File" menu options is only available 
when the Host active option is selected to return data to a headquarter 
system. The "send to host" option will output the changes made on the 
local L-BOSS machine back to a host system. This means that 
changes to prices, accounts and other files can be made at a store and 
sent back up to the host system. Select this option for the tables that 
may be edited locally in a store. When this option is selected for any 
item in a table it means that any change made to any record in that 
table can be returned to host. The changes are not sent for each 
record you change, they are only sent when you force the change to 

be sent. This is done by clicking on the 

 

send terminal icon that is 
normally used to transmit an individual record to the local targets (in 
this case it would be the POS lanes in the local store.) Please consider 
as well that changes sent back up to the headquarter system will be 
deployed to all target terminals that are part of the same target group 
for that file type. This means that if an account is changed at store 3 
and all stores share the information on that customer, the change will 
make it to the other stores in the next communication cycle. 

 

Note: Only the records deployed with the 

 

deploy individual record 
icon are sent to host, and only when the Send to host option has been 
selected for that type of file. 
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Editing tools  

Regardless of which data table you edit, the Maintenance application provides a common set of tools on a toolbar 
at the top of the data table editor. The Maintenance main menus change as well, depending on the table you are 
programming. The toolbar is common to all tables you edit.  

   

Apply changes tool allows you to post the changes to the record within the table being accessed. 

 

Add new record tool is used to add a new blank record to the table you are working with. To copy an existing 
item to a new item, or to replace an existing item with a new number, enter the number directly into the item 
number field. You will then be prompted for the action you want to take. 

 

Delete tool is used to delete an existing record from the table you are working with. 

 

Ignore changes tool is used to undo changes that appear on the screen but that have not yet been posted. It 
will not undo changes that have been posted. 

 

Previous record tool is used to go back to the previous record in the table you are working with. 

 

Next record tool is used to go forward to the next record in the table you are working with. 

 

Send one record tool is used to send the modification made to the current record to the POS terminals 
immediately. This icon changes color to green when a modification has been made to a record. When the record is 
deployed the icon will return to the normal color displayed here.  Clicking the satellite will send the current record to 
the POS terminals whether a change was made or not. 

 

Save and close tool will save the current changes and close the table you are editing.  

NOTE: L-BOSS saves new data in a field once you press tab, enter or when you click in another field. Data is also 
saved when you access another record in the table, or when you open a new table. This means that you do not 

need to press the post tool 

 

after each record you modify, L-BOSS does it automatically for you. 
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Displaying search lists  

L-BOSS uses tables to store data. In some cases the information stored in a table has been indexed so that a rapid 
search can be performed to locate data you require. As you are navigating through the fields of different tables you 
will notice that sometimes a "?" (Question mark) appears beside the cursor. This means that the selected field is 
indexed so that its contents are viewable as a searchable list. Double clicking the selected field will open a viewable 
list of the table's contents.   

The sequential order that the contents will appear depends on which field you have selected for the drop down list. 
For example, if you are editing accounts and double click in the account number field, the list is in numerical order 
according to the account numbers. Double clicking the account name field opens the same information, but listed 
alphabetically according to the account names. The data list's left column will contain the data from the field 
selected.   

Here is a sample of the account search window:  

  

When this type of list is open, you can have many search options. Clicking at the top of any column will use that 
column to sort the data. From the example shown above, if you click on the column header “Company” the list will 
sort in alphabetical order by company name. If you click again in the same column the list will sort again in 
alphabetical order starting from the opposite end of the alphabet. Click in the Acc # column header and the same 
list will sort numerically. Re-click the Acc # number and the list will sort from the last account to the first, etc. You 
can also use the locate entry window to type data. If you have sorted the column by clicking in the Acc # number 
field, the locate tool will search the Account number field. If you have sorted the column by clicking in the company 
field, the locate tool will search the item description field (F29 in the database.) You can sort all the other fields the 
same way by clicking that column header.  
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You can also use this type of search window to perform a wildcard search (the field you are searching contains the 
data in a continuous string.) For example you want to search for all accounts that include the word BEST anywhere 
in the company name. Type the word Best into the locate window. The system will display the first account it 
locates beginning with the word Best. Press the Enh. Search button. The system will display every account that 
includes the word best. So the first list may show no results unless there are accounts that start with Best. But the 
second list would show Best Company, All the Best, etc.  

The File menu option in the search window allows you to send the data from the search list to an export file or to a 
printer. This is a simple way to print a very specific list: set a filter to find your items. The Apply button will produce 
this type of search list that can then be printed (or exported to a csv file.)  

The next major advantage to this type of list is that a customized query can be defined if you understand the LBoss 
database structure and you have a minimum knowledge of sql commands. Access the options menu and select 
custom query. The system will open up an sql editor window. Add the commands you need to select the data you 
want to list. If you are unsure how to do this it is recommended that you inquire with your dealer on how to add 
custom queries.   

Windows menu  

Like many Windows based programs, the Maintenance application allows you to have more than one window 
(table) open at the same time. The Window menu contains options that allow you to control how the windows or 
tables appear on the desktop.    

Cascade: This aligns the open windows in layers, with the corners and title bars of all open windows visible, 
enabling you to find the window you a looking for.  

Tile: This option tries to place all the open windows into the Maintenance application's desktop by re-sizing them.  

Close All: Closes all open windows at once.  

Selecting open windows from a list: If you have multiple windows open on the desktop, you can open the "Window" 
menu and select the window to "bring to front" from the list at the bottom of the menu.  
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Creating risk levels  

Dealing with customer charge accounts involves risks. There is the risk of allowing a customer to post a charge and 
then losing the revenue if the customer does not pay his account. There is also the risk of accepting bad checks 
from customers.  

The Risk level table allows you to 
administrate risk levels where you set 
charge privileges and check payment 
privileges. An unlimited number of risk levels 
can be added to allow complete flexibility in 
determining what risk a particular customer 
represents for your business.       

Create risk levels as required to manage your accounts. The number you assign here will be used to identify this 
risk level when you are creating client records.  

Press the + icon to add a new risk level.  

  

From the maintenance application 
main menu, access the Accounts 
menu and open the risk level table.  

Assign a description to the risk level record. 
Max credit: Use this field to limit the credit that will be available for this 
customer.  A client with a $200 credit limit and a current balance of 
$175 will be able to charge up to $25 more.  
Check limit: Enter the maximum check payment amount for all clients 
assigned to this risk level. The check limit is the maximum you accept 
from this level for an individual check. 
Check change limit: Enter the maximum change you will remit to 
clients assigned to this level. 
Check week limit: Enter the quantity of checks the customer can use 
in one week in the first field and the maximum check payment amount 
in the second field. 
Accept check: This field allows you to determine whether customers 
on this level can pay by check. Double-click this field to choose from 
1- Accept check 
2- Manager required 
3- don’t accept 
Interest rate: Enter the annual interest rate that will be charged to 
clients on this risk level for past due invoices. 
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Creating customer levels  

Storeowners often encourage their good customers by setting up a preferred shopper program. L-BOSS includes 
features that can be used to reward customers with immediate benefits or with incentives that accumulate over 
time. Although some of the features require the preferred shopper license, you must assign a customer level to 
each account to be able to use the accounts receivable option.              

The Customer level table allows you to define shopper levels where rewards can vary by level. You can create 
multiple customer levels as required. Within each customer level record you assign a price level and / or a discount 
percentage. The POS will combine these 2 fields when the customer account is opened for a transaction.   

       

From the maintenance application main 
menu, access the Accounts menu and 
open the Client level table.  

 

Level Number:  Enter the level number you want to program.   

Description:  Enter a brief description of this customer shopper level 
(Regular, gold card, super-saver, etc.)  

Price level:  Enter the price level that members of this customer 
group will receive. Remember to create these price levels under the 
item related maintenance. You must enter a price level.  

Discount:  Enter the discount that members of this customer level 
will receive on discountable products. This field is not compulsory. 
The customer level discounts will apply to the transaction total without 
netting the item sales. If you are working with L-POS this default 
behavior can be changed and the discount will apply directly to each 
line item in the transaction. This change is made in 
PosSetup>System>Account.   
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Customer accounts  

L-BOSS allows you to create an unlimited number of records within the Client (or customer) table. Each customer 
account can have multiple sub-accounts or "Contacts" (account users), but must have a "main" user. Accounts 
must be linked to both a risk level and a customer level.  

 

Client number: This field is used to enter the 
number that will be used to retrieve the customer 
record in both the L-POS lanes and L-BOSS 
stations. Several considerations should be made 
when deciding on the account numbering system 
you will use. Although the field allows you to use 
alphanumeric characters to identify the account, this 
becomes more of a problem when it is time to input 
the numbers on the POS: numeric only numbers are 
much easier (and faster) to enter. The client number 
can be up to 20 digits. 

 

Modified: The L-POS stations can be configured to 
allow the creation of customers "on the fly". The 
POS will prompt for the minimum information 
required to create the account, and then send the 
new account to the back end. When a customer is 
created from the front end and sent to the back end, 
the dot beside "Modified" will be red, to identify 
accounts that were created in the front end, and 
probably need to be edited to complete the 

information. 

 

Detail: This option is available if your system is licensed to use the L-Tracker option. When you press the Detail 
button a new window will open and L-BOSS will begin processing the electronic sales journal files for the last 5 
weeks, unless this has already been done. This will in turn create a list of all the transactions involving the 
account over that period. You can view details for previous periods by selecting the appropriate start date on 
the calendar. 

 

PAL: The pull-down field to the right will probably show PAL as the target group. The target allows you to 
specify, in multi-store environments, which programming zone this data will be sent to. In single store 
applications this should show PAL for all accounts. If you only want customer X to be sent to store 5, you would 
create a program target for store 5 and put that target on client record 5. Note that the client account file is 
different than the PLU file. You may have multiple targets for items. This means the item is really in the file 
several times, one programming set-up for each target. Each account can only exist once; you cannot have the 
same account with multiple targets. 

 

Company: Enter the company if required. 

 

Address, City, Prov/State, Code and Country entered here will be displayed on account statements or other 
customer based reports. L-BOSS also provides a statement report that prints the address so that it can be 
folded and sent in a standard "windowed" envelope. 

 

Expiry is the date until which this account remains active. People who charge membership fees should set the 
date when renewal is due for this account. The renewal date can be modified here by changing the date or 
through the L-POS if certain options are set. See the related programming in PosSetup>System>Account. 

 

Phone and fax are used to enter the telecommunications data for the customer. Because of international 
considerations no formatting is done in these fields. 

 

Card # and Exp: Use these fields to record customer credit card information. This information is provided as 
information and it is not used by the system automatically. For example, you may have an agreement with your 
customers that you can automatically invoice their credit card account when a rental item is lost. 
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Tax 1 Exempt and Tax 2 Exempt should be entered if you want the L-POS front end to exempt taxes that would 
have applied to the items in the transaction. These are individual flags. You do not need to exempt one tax for 
the other tax to be exempted. 

 
Note: L-POS can use up to 4 tax rates. You may enter a Tax 3 Exempt by clicking on the descriptor for Tax 1 
Exempt. A window will open where you can record the tax 3 exempt number. You may enter a Tax 4 Exempt by 
clicking on the descriptor for Tax 2 Exempt. A window will open where you can record the tax 4 exempt 
number. 

 

Group is used by the report system to filter the customer file and only produce a report for the category 
selected. It is not a compulsory field. For example, you want account statement reports for certain customers 
every 30 days while other customers are never sent a statement. You could type 30 days in the group field for 
the first customers and never in the other group. Then when you want to print the statement reports you would 
filter by group "30 days." Once entries have been made into this field you will be able to click in the field to 
choose from the existing data entered into other customers. 

 

Balance is the current online charge balance for this customer. 

 

Points are the customer point amount that has accumulated. 

 

Risk Level: Select the proper risk level assigned to this account. The risk level controls both store charge and 
check cashing privileges. The risk levels are created in the Client risk table programming. 

 

Client level: Select the proper customer level used by this account. The customer level may offer a discount or 
a price level other than the default price. This is set up in the Client level programming under the Account 
menu. 

 

NOTE: The Risk and Customer level tables should be programmed before creating accounts in the system, 
making it easy to select both Risk and Customer levels from a pop-up list. 

 

Contact Required: Set this option to on if L-POS should require the contact number to be entered along with the 
account number. Account statements and other account reports will show information from all contacts for the 
account as a single account. To be able to track each contact's transaction information, the contact number 
must be included when entering the account number at L-POS lanes. L-POS lanes can be set to require the 
contact number by setting the "Contact Required" flag on. 

 

PO # required: This flag will force the entry of a purchase order number whenever this account tries to make a 
charge. 

 

PO# Digits Min/Max: Set the minimum and maximum number of digits allowed for PO # entry for accounts with 
a PO# required.  

Deleting and Modifying Account Numbers  

L-BOSS will not allow you to modify an account number, or delete that account if there is an account charge 
balance. Before trying to delete or modify account numbers, set the balance to zero (see the "balance" option in the 
client table). If an account number is modified or the account is deleted, past transactions will still appear on reports 
for that period. If you create a new account with a previously used account number, past transactions viewed in 
reports for that account will show as if they belong new account.  

NOTE: Payments made to accounts on the POS terminals do not

 

apply to specific transactions. Amounts received 
as payment on accounts apply to the previous balance.  

Customer contacts  

Customer records require that contact information be entered. The contact is the person using the account. Each 
customer must have a main contact and may have as many additional contacts as required. This in turns provides 
both the customer and the store with information on which contact used the account for a given transaction.  

Each account must have

 

a "main" contact. Additional account users (contacts) can be added using the "+" button, 
or removed using the scissor button from the tool bar in the contact section. The left and right arrow buttons are 
used to move to the next / previous contact.  
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Number: This field contains the contact's number, 
assigned to a contact when it is created. A contact 
number may be required along with the account 
number at the POS to use the account if the "Contact 
Required" flag is set to on. If no contact number is 
entered, the transaction will be linked to the "main" 
contact. The "main" contact always appears as the 
first contact. 

 

First name: Enter the contact's first name. 

 

Last name: Enter the contact's last name. 

 

Language: This field allows you to set the default 
language the system will display for this customer, English or French. L-POS will print receipts based on the 
customer's default language. Account statements will also print using the default language. 

 

Extension: Is the contact's office telephone extension. 

 

Birth: Enter the contact's birth date. If entered it will be used to validate age-restricted items. 

 

Home: This field can contain the contact's main telephone number, pager, or other number. The title to the left 
of the field is in red, and can be modified by clicking the title and entering the phone type. (In the example 
shown above, the title is "Pager"). Note: This field can be used to store additional checking account numbers 
for this customer. On check transactions the POS will verify the main account number, and all contacts of that 
account home phone number field for a matching check account number. So if you get a bad check from the 
customer you can refuse checks from all his accounts this way without creating more account records. You only 
need to add contacts and place the check account number in the home phone number field. By adding 
additional contacts you will be able to store as many bad check numbers as required per account. 

 

Cellular: This is an alternate number for the contact. 

 

Email: This is the contact's email address, entered here for office reference only. 

 

Remark: This is a per-contact message that can be programmed to appear on the POS display when this 
account contact is used. 

 

Then icon opens a window where 
you can add contact specific information 
into 5 text fields. Use these fields to build 
reports as required. The fields can 
contain information such as driver’s 
license, favorite wine, or anything else 
you may need to track for your accounts. 
The field titles are info field 1 to info field 
5 by default. These screen labels can be 
changed by opening the L-BOSS 
configuration menu and accessing the 
Advanced flag settings. Here is the 
contact table extra info fields window.       

Note: If the current cashier's phone number matches the account phone number or the account contact phone or 
cell number the transaction will not be allowed. This is to prohibit cashiers from using their own account to sell to 
themselves or to others with their own account discount. If you want a cashier to be able to sell something to his 
own account you must ensure the phone number of the cashier is different than the phone numbers of the account 
contact.  
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Associating a Photo with a Customer contact  

L-BOSS and L-POS can also be configured to display a photo of the customer, ideal for visual confirmation. The 
photo can be for office use only, or also sent to the front end. The POS screen must be programmed to display the 
photo when the account number (and contact number) is entered at the POS.  

NOTE: When the customer table is being edited 
the Menu bar is modified to include a View 
option.   

This is where you can toggle on or off the displaying of the customer photo on the maintenance screen. Click the 
"View" menu from the Maintenance top bar menus select the "Picture" option. The customer table window expands 
to display a picture box, with "Browse" and "Delete" buttons.        

The naming convention for the 
customer id photo is fixed to allow 
quick lookup of the photo within 
the POS application. L-BOSS and 
L-POS can display either bmp or 
jpg files. The filename must be 
"cltxx-y.jpg" where xx is the 
account number (set to the same 
value as the actual account 
number) and where y is the 
contact number. By way of 
example, for customer 101 main 
contact the photo filename must 
be "clt101-0.jpg". Whenever an 
image is selected and the 
filename does not meet the 
naming convention rules it will be 
copied or renamed to the correct 
name by the application.    

Use the Browse option to 
locate the contact's photo file 
or Delete to remove the 
associated photo. 

The View menu
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Custom messages for statements  

Use this option to modify the messages that are printed on account statements issued from the L-BOSS reporting 
system.   
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Sending the account files to L-POS  

Sending data from Maintenance while editing  

   

The "Transfer" menu is only visible if the account tables are opened for editing. After editing information in a table, 
you can send the modifications either by using the satellite dish button on the edit table toolbar, or from the 
"Transfer" drop down menu. The "Transfer" menu allows you to send the currently selected record or the entire file. 
In most cases sending the entire file is not suggested or required, but doesn't really cause any problem.    

When you need to send one account record to 
your front-end terminals the quickest way is to 
locate the record in the account maintenance 
module and click the satellite. This will send all 
the information related to that account 
including the customer record, the contacts, 
the images, the risk levels and the customer 
level information. Click the satellite and the 
following window will appear: 

  

Select Yes to send the current 
account to all terminals. 

 

Select No or Cancel to abort the 
procedure. 

 

Select All to send all accounts to 
all targets.
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Sending account related files manually   

  

From the list of files that opens you need 
to select one or several files. Click any 
file to send it to a specific target. To send 
multiple files proceed as follows: while 
holding the CTRL button on your 
keyboard click on several files. The 
accounts need CLC_TAB and the 
CLT_TAB. To replace the existing files 
on the POS terminals place a check 
mark in the Replace field. (You may 
need a higher access level, if so contact 
your dealer) When this is done press the 
Deploy button.  

It may be necessary to send specific account file data to 
the POS terminals. When this needs to be done open 
L-BOSS>File>Deploy individual file
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Note: You may also need to send the risk levels or the 
customer levels to the POS terminals. Return to step one 
where you selected CLC_TAB and CLT_TAB. Select 
CLR_TAB (risk table) and CLF_TAB (shopper level). 
Then follow the same steps to deploy to the lanes. 
Note 2: You may not be authorized to select Replace 
when you deploy individual files. The difference between 
deploy with replace is that the files you are deploying to 
the target machines will be erased when Replace is 
selected. All existing data will be replaced. Otherwise the 
new data you send will be merged to the existing data.            

Setting up L-POS for accounts receivables  

System settings 

             
Once you have selected Deploy a list will appear with the available 
targets that should be waiting to receive the data files. Select the target 
(normally PAL). Selecting PAL means the data will go to all the terminals 
included in the PAL target terminal group. This means that the data will 
be sent to all terminals. If you want to send the data to only one terminal 
select the programming target that includes only that terminal. 

 

Several decisions must be made before you begin using 
customer accounts on L-POS. Access the 
PosSetup>System>Account tab. This can be done from the L-
POS transaction screen and selecting System from the pull-
down menu. 

Click the serial number to view the PosSetup menu
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You can also start Pos Setup from the C:\Poswin folder of any lane by running the PosSetup.exe program from 
that folder.                            

Print options        

 

Print account name will show the customer company name on the receipt. 

 

Print contact name will show the customer fist name and last name (from the 
contact table) on the receipt. 

 

Print account number will show the customer account number on the 
receipt. 

 

Print full address will show the full customer address on the receipt. 

 

Print account summary will print a transaction summary for the charge 
transactions on the bottom of the customer receipt. 

 

Print stub receipt will print a stub receipt for the charge transactions after the 
customer receipt has been printed. 

 

Print account balance will print the customer charge balance at the start and 
end of the transaction whenever a charge or payment is made to the 
account. 

 

Print account comment will print the POS comment entered for the account 
on the back-end account set-up software. 

 

Note: In order to print the account information in double width refer to Printer 
set-up under peripherals. 

 

This screen displays the options that affect 
the way customer charge transactions 
behave and print. For example you can 
decide to print the account name and the 
contact name or neither. Does the system 
look up the account balance?  The account 
settings are global settings that affect all 
account transactions. The screen has 3 
areas. Print options, Behavior, and 
Account discount settings.  
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Behavior options  

This section allows you to define the way the accounts will respond when an account is opened on the POS.  

                         

Account discounts settings.  

These settings allow you to decide how discounts will be applied to the items that are discounted. This discount 
refers to the discounts that were assigned in the client level table for each customer.  

    
Get account balance will send a request to the backend server for the up-to-
date customer charge account balance and retrieve it into the sale if 
available. If the backend is unavailable the operator will be prompted to 
abort the transaction or continue without the up to date customer account 
balance. 

 

Compulsory means that an account number must be supplied for every 
transaction.  

 

Must be first means that when an account is used it must be the first entry in 
the transaction or it will be refused. 

 

Confirmation means that the operator will be prompted with the account 
name when the account number is entered. The operator will be able to 
confirm acceptance or refusal of the account look-up. 

 

Extend expiry date can be used when the customer account expiration date 
has been exceeded. The system will add one year to today's date and set 
the new expiry date. You can also execute a button automatically when this 
feature is used. The Account renewal fee button is assigned on the same 
page. It is available when the Extend expiry date is enabled. This is useful if 
you want to charge a fee to extend the expiry date. You need to program the 
button properties in button & form set-up. 

 

Accept not-found customers allows the front-end L-POS to send new 
customer data to the back-end system. 

 

Create in back-end will send a new account record to backend L-BOSS 
system. 

 

The Prompts button allows you to select the prompts that the POS will display when creating a 
new account directly on the L-POS terminal.

 

The account renewal fee button is used to select a button that was programmed to collect a 
fee for extending the account expiration directly from the L-POS. It is not available if the 
extend account expiry date is not set. Choose a button from the button list that the POS will 
execute when the expiry date is extended on the POS. 

Select Apply % to each item to apply the customer discount 
as in item discount rather than as a sub-total discount. The 
account discounts use function 412 for global discounts and 
function 452 for item discounts. 
The Use discount table must be selected on systems using 
preferred shoppers with the account discount table.  
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Creating keyboard buttons for account transactions  

You need to create several buttons in order to use the Accounts receivables option on L-POS. The system requires 
at least an Account # button, a Charge button, an R/A (received on account). You may also decide to add a 
Report button that displays a list of transactions by customer from the POS screen.  

Access PosSetup > Buttons & Forms.  

                 

Modifying the Account # button  

 

Click on the serial number and select Buttons & Forms from 
the pull-down menu. 

1. Locate the account button.

 

2.The Account button must use function 
305 to open a customer account on the 
L-POS.

 

3. Several settings 
related to the Customer 
ID function 305 can be 
made if you click the 
properties icon.

 




